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Introduction
Mother Of All Battles is a game for 1 to 6 human or computer players. The object of the 
game is to destroy all the opposition's pieces by exploring new territory and capturing as 
many neutral and enemy cities as you can in order to build more of your own pieces.
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The Pieces

 Army. The most common piece used. Armies are quick to build but are very slow moving. 
Use them to defend your own islands or load them onto your transports to capture new 
islands.

 Para. Paras move quickly but take much longer to build than armies. When 'dropped' they
become armies. They are very useful for doing quick attacks on poorly defended enemy 
islands.

 Fighter. Fighters take a long time to build but are the fastest moving pieces in the game. 
They are excellent for exploring new areas, reconnoitring and destroying enemy pieces, 
especially bombers, paras, submarines and transports.

 Bomber. Bombers take a long time to build but are devastating if exploded on densely 
packed enemy forces.

 Transport. Very quick to build. Transports can carry up to 6 armies, but are very 
vulnerable to attack from enemy pieces.

 Destroyer. The fastest moving ship in the game and very effective at dealing with enemy
submarines and transports.

 Submarine. Submarines are very effective against enemy transports and battleships but 
are vulnerable to destroyers and fighters.

 Aircraft Carrier. Aircraft carriers can carry up to 6 fighters and can refuel them.

 Battleship. Probably the most powerful piece you can build. Devastating against enemy 
tanks on the coast, destroyers, aircraft carriers, transports and any aircraft, but watch out 
for enemy submarines!



Starting A Game

To start a game, click on the File menu. You can then click on either:

New start a brand new game.
Open open an old one that you have saved earlier.
Demo watch a demo game.

If you start a new game you can choose whether the players will be out of the game or 
human or computer controlled. You can also choose how large you want the world to be and 
how difficult the computer players will be to beat.
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Building New Pieces

When you begin a new game a 'City Information' dialog box will appear asking you what you 
wish to build at your first city. This dialog box can be called up at any time during a game by 
clicking the right hand mouse button while the mouse is over one of your cities or over a 
city's entry in the 'Production' window, and will also be automatically displayed when you 
capture a new city.

The time taken to build a pieces at a city is as follows:

 Army 4    days
 Para 8 days
 Fighter 8 days
 Bomber 12 days
 Transport 2 days
 Destroyer 6 days
 Submarine 6 days
 Aircraft Carrier 10 days
 Battleship 12 days

You can change what the city is building by clicking on the button of one of the different 
types of pieces, however you will have wasted any time that has been spent partially 
building the old piece.

Ships can only be built in ports (cities which are adjacent to a blue, sea square).
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Selecting And Waking A Piece

The piece currently selected for you to move will be the one which the line coming from the 
mouse points to.

To select a different piece, click on it with the right hand mouse button - this will also wake it 
up if it was asleep. If that piece still has movement points left for the day, the line from the 
mouse will jump to that piece. If the piece does not respond, it is because it has already 
moved as much as it can or it has attacked an enemy piece this day.

If there are several pieces stacked on top of one another you can cycle through them by 
continually clicking the right hand button on the stack. To do this to a stack of pieces which 
are in a city, hold the SHIFT key down while clicking the right hand button on the stack. 

To wake a piece which is in a city, click the right hand mouse button on the city to bring up 
the 'City Information' dialog box. Then click on the pieces in the 'Awake' or 'Asleep' boxes to 
change their status.

You can centre the currently selected piece on the screen by selecting 'Current piece' from 
the 'View' menu or by pressing the 'C' key. If you wish to view your starting island, select 
'Home' from the 'View' menu or press the 'Home' key.
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Moving A Piece

To move the currently selected piece, click the left hand button on the square that you want 
the piece to move to. The movement points that a piece gets at the beginning of a day and 
the fuel for planes when fully refuelled are:

Movement Fuel
 Army 1 unlimited
 Para 7 28
 Fighter 14 14
 Bomber 7 28
 Destroyer 6 unlimited
 Battleship 4 unlimited
 Carrier 4 unlimited
 Transport 4 unlimited
 Submarine 4 unlimited

As ships become damaged their number of movements points will reduce.

If you tell a piece to move further than it is allowed to in one day it will remember where you
told it to move to and will carry on moving there in subsequent days (unless move memory 
has been disabled from the Options menu). You can cancel a piece's orders by clicking the 
right hand mouse button on it.

When a plane realises that it must return to refuel it will do so automatically. Fighters can 
refuel on aircraft carriers as well as in cities.

Armies cannot move out to sea except for moving on to transports. When an army moves on
to a transport it is automatically 'slept'. To wake it up to disembark, click on it with the right 
hand mouse button. Only up to six armies will fit on each transport.

Armies cannot be put on top of one another except for in cities and on transports.

The worlds used in this game "wrap around". This means that if you move your pieces far 
enough they will go right around the world and eventually come back to where they started.
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Special Moves

The following moves can be performed on the currently selected piece by selecting the 
move from the Moves menu, or by pressing the first letter of the move on the keyboard, or 
by clicking on a button in the button bar.

 Drop
Can only be done to paras while over open land. The para will be converted to an army.

 Later
Another piece with movement points left is automatically selected. You can come back and 
move the old piece later in the day.

 Finished
Another piece is automatically selected but the current piece loses all its movement points 
for this day.

 Return
The piece moves back to the nearest city.

 Sleep
The piece can't be moved again until either it is attacked by the enemy or it is woken by 
clicking on it with the right hand mouse button.

These options can be selected at any time: 

 End Turn
When you have moved all the pieces that you think need moving this turn, select this option.
All unmoved planes will return to their nearest city, other pieces will lose all of their 
remaining movement points.

 Surrender
If your position has become unwinnable you can resign from the game. All of your pieces will
be destroyed and the other players will continue playing.
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Attacking Enemy Pieces And Repairing

To attack an enemy piece simply move your currently selected piece on to the square the 
enemy piece is on. Damage will be inflicted on the enemy, and if its strength falls below zero
it will be destroyed. Attacking an enemy piece uses up all of the piece's remaining 
movement points.

When you attack an enemy piece with a bomber, the enemy piece and everything within 
two squares of it will be destroyed, including any of your own pieces caught in the blast!

Different types of pieces have varying strengths of attack on enemy pieces. For example, a 
fighter will easily shoot down a bomber or para, a submarine will severely damage a 
battleship, transport or aircraft carrier, whereas a destroyer will have little effect against an 
army.

A piece which has been damaged by an enemy attack can be repaired by moving it to a 
friendly city. To heal a ship it must be left next to a friendly port, all other pieces must be left
in any friendly city. Pieces left there are gradually repaired at the beginning of every day.

The number of moves a ship has at the beginning of a day will decrease as it becomes more 
damaged.
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The Status Windows

The following status windows can be switched on and off by selecting them from the View 
menu, or by pressing the underlined letter in the window's name:

Game Info
Shows you whose turn it is, what day it is, what the difficulty level is and how large the world
is.

Rankings
Shows you which player has the most cities and the largest army, navy and airforce. The 
further your colour is to the left, the better you are doing.

Piece Info
Shows you what the currently selected piece is, how many moves and how much fuel it has.

Production
Shows you what your cities are building and how long they have left until completing it. The 
city's name will appear next to it when you move the mouse over an entry in this window. 
Clicking the left hand button on an entry will centre that city on the screen. Clicking the right
hand button will bring up a 'City Information' dialog box allowing you to change what the city
is building (equivalent to clicking the right hand button on the actual city itself).

World Map
Shows you a view of the whole world. Clicking on any part of the map will centre the main 
screen on where you clicked.
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Options

Sound
Select whether you want the game to run silently, use the PC speaker, or if you have one, a 
sound card.

Colour Monitor
Unchecking this option will invert the colour of all enemy pieces to make it easier to 
distinguish your own on a monochrome monitor.

Prompt On New Player
This option is only useful when several humans are playing. Checking it will bring up a 
warning window at the beginning of each human's turn, preventing other humans from 
accidentally seeing each other's pieces.

Auto Play
Checking this option will make the computer control your pieces.    This is useful when you 
have nearly won the game but can't be bothered to kill every last enemy piece yourself. You 
can regain control at any time by unchecking the option.
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Saving And Exiting A Game

You can save your game at any time by clicking on File and then Save. Your game is also 
automatically saved after every 7 days of play, and if you open or start a new game or 
demo.

To exit the program, click on File and then Exit. Your game will automatically be saved.
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Version History

2.0 May '96
- 16 and 32 bit versions.
- Much improved computer intelligence.
- Piece moves, fuel and days to build can be customised.
- Choice of which types of pieces will be used in each game. 
- Button bar added.
- Larger world sizes.
- Configurable amount of land mass. 
- 'Move memory' is now optional.
- Windows automatically 'tidied'.

1.3 March '95
- Ships take fewer days to build.
- Armies can't attack from a transport.
- Mouse cursor displays how far the piece is going to move.
- City information window shows how many more days are left to build any piece.

1.2    February '94
- Comes with an installer program.
- Zoom in and out.
- Click on pieces in the 'City Information' window to wake and sleep them.
- Immediate detection for players being eliminated.
- 'End Turn' option.
- Press Shift + right hand click to rotate through a stack of pieces in a city.
- Citys name appears when the mouse is over the 'Production' window.
- Sound card sound effects.

1.1    December '93
- 3D style islands.
- Modeless windows used for 'Rankings', 'Piece Info', 'Production' and 'World Map'.
- 'Game Info' window added.
- Cities have names.
- Humans are prompted before their turns so they can't see other humans moving.
- Other players continue when one human player surrenders.
- Monochrome monitor option.
- Auto play option.
- 4 world sizes and 4 difficulty levels.
- Proper hypertext help file. 

1.0    August '93
- Up to 6 human or computer players.
- 3 world sizes and 3 difficulty levels.
- Windows used for 'City Information', 'Rankings', 'Piece Info', 'Production' and 'World Map'.
- Simple help file.
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Order Form

The full copy of Mother Of All Battles allows you to choose games of between 2 
and 6 computer or human players on a randomly generated world. To order a full 
copy, please send:

UK orders: (spto@cityscape.co.uk)
£20 per copy to Sean O'Connor,
62 Whitney Drive, Stevenage, Herts, SG1 4BJ, England.
pay by: cash, cheques or Eurocheques in pounds sterling.

US orders: (73733.1014@compuserve.com)
$30 per copy to Cade Roux,
c/o Dubroca, Box 513, Boutte, LA 70039, USA.
pay by: cash or cheques in US dollars.

European orders: (eurovga@ibm.net)
200DKK per copy to Henrik Moerk, 
Survival BBS, P.o. Box 1538, DK-2700 bronshoj, Denmark. +45 3889 5253
pay by: credit card, cash, Eurocheques in Danish crowns, or (euro)GIRO (1-207-4247) 

New Zealand and Australia: (jen@enternet.co.nz)
NZ$55 per copy to Jenni Ducey,
JayDee Productions, 37 Taniwha Place, R.D.2, Tauranga, North Island, New Zealand.

Name:_______________________________________

Address:_____________________________________

____________________________________________

____________________________________________

____________________________________________

Number of copies ordered: _____

Amount enclosed: ______________

Out of interest, where did you see the demo version of Mother Of All Battles 
(please specify)?

 Magazine __________________

 BBS __________________

 Internet site __________________

 Other __________________

If you have a printer, this order form can be printed out by clicking on Print Topic from the
File menu.





Credit Card Order Form

Survival BBS
C/O Henrik Paludan-Moerk
Hvalsovej 1, 3tv
Po Box 1538
DK-2700 Bronshoj
Denmark
email: eurovga@ibm.net

YOUR

Name      :________________________________________________________

Address:________________________________________________________
              

Zip[mailcode], City: ___________________________________________

Country: _______________________________________________________

Daytime Telephone No.: _________________________________________

* If you wish the product sent to a different delivery address,
* please specify:
*
* 
* 
* 
* 

Card type (please circle) Danish Dan-kort * VISA * Eurocard/Mastercard * JCB

Credit card details: 

No.: |_,_,_,_|    |_,_,_,_|    |_,_,_,_|    |_,_,_,_|      expires    |_,_ / _,_|

Ordering:

[      ] Mother of All Battles @ 200 Dkk
[      ] Slay @ 200 Dkk
[      ] Critical Mass @ 200 Dkk
[      ] Rats! @ 150 Dkk
[      ] Revolution @ 150 Dkk
[      ] Sound Effects Generator @ 100 Dkk

Prices include European VAT and postage (prioritaire).

Authorised amount to deduct off credit card:[                            ] danish crowns



Date of signature:    ______________________

Signature

___________________________________________________________________




